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1 About this Manual

The Manual contains information on the Lenze Cam Designer Professional V2.3.

The »Cam Designer Professional« is a software which serves to create transfer recipes con-
sisting of motion profiles, cam tracks and position markers, and transfer them from a PC to
Lenze target systems.

Special features of the »Cam Designer Professional« are:

 Import of CAD data via standardised interfaces (VDI 2143).

 Operation of the program via a convenient PC user interface.

 Automatic smoothing of imported CAD data (motion profiles) for a smoother running 
of the drives.

 Easy creation of cams by means of graphic objects (e.g. lines, polynomials).

 Data is directly input using the physical unit.

 Assistance in drive dimensioning.

 Automatic generation of connections according to the motion rules (VDI 2143) by using 
an expert system (jerk-free movements for protecting the mechanics).

 Display of speed, acceleration and jerk.

 Creation of value pairs (position, speed or acceleration) for direct cam profile accept-
ance in Global Drive Control.

 Project management (statistics, author, version, date/time) and mail support.

 Printing of a cam graphics with project information and date.

1.1 Conventions used

This Manual uses the following conventions to distinguish between different types of in-
formation:

Type of information Marking Examples/notes

Variable identifier italic Set bEnable to TRUE to...

Window The message window... / The  Options dialog box...

Control element bold The OK button... / The Copy command... / The Properties tab... / The 
Name input field...

Sequence of menu 
commands

If the execution of a function requires several commands, the individual 
commands are separated by an arrow: Select FileOpen to...

Keyboard command <bold> Use <F1> to call the Online Help.

If a command requires a combination of keys, a "+" is placed between 
the key symbols:
Use <Shift>+<ESC> to...

Program listings Courier IF var1 < var2 THEN
    a = a + 1
    END IF

Keyword Courier 
bold

Link underlined Links are highlighted references which are activated by means of a 
mouse click.

Safety information  �Layout of the safety information  ( 7) 
L 3.0 EN - 08/2005 5
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Step-by-step
instructions  Like safety information, step-by-step instructions and tips can be recog-

nised by an icon.

Tip 

Type of information Marking Examples/notes
6 3.0 EN - 08/2005 L
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1.2 Layout of the safety information

All safety information have a uniform structure:

 The icon characterises the type of danger.

 The signal word characterises the severity of danger.

 The note describes the danger and suggests how to avoid the danger.

 Signal word

Note

Icon Signal word Meaning Consequences if disregarded



hazardous 
electrical 
voltage



general
danger

Danger! Impending danger to persons Death or severe injuries

 Stop! Potential damage to material Damage to the controller or its environment

 Note! Note
L 3.0 EN - 08/2005 7
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2 System requirements

The following minimum requirements on hardware and software must be met to use the
»Cam Designer Professional«.

 Microsoft® Windows ME®, Microsoft® Windows NT® 4.0 (as of Service Pack 5), Win-
dows® 2000 (as of Service Pack 2) or Windows XP

 64 MByte RAM
128 MByte RAM (XP, 2000)

 IBM compatible PC (CPU: Pentium 90 MHz processor or faster)

 Super VGA screen

 Hard disk with at least 120 MB of free disk space

 CD-ROM drive

 Mouse (Microsoft-compatible)

2.1 Connection with the target system

The communication with the target system (controller, Drive PLC, etc.) requires a fieldbus-
specific interface module for the PC and the corresponding fieldbus modules for the target
systems to be connected.

For system bus (CAN) communication, Lenze offers the following components as interface
module for the PC:

Bus system Max. number of target systems

PC port Required hardware components

System bus (CANopen) 63

Parallel
port
(LPT port)

PC system bus adapter 2173
incl. connecting cable and voltage supply adapter
 • for DIN keyboard connection

(EMF2173IB)
 • for PS/2 keyboard connection

(EMF2173IBV002)
 • for PS/2 keyboard connection with electrical isolation

(EMF2173IBV003)

USB
(Universal Serial Bus)

PC system bus adapter 2177
incl. connection cable
(EMF2177IB)

efesotomasyon.com - Lenze
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3 Software installation

 How to install the »Cam Designer Professional«:

1. Start Windows.

2. Insert the CD-ROM »Cam Designer Professional« into the CD-ROM drive.

 • If the auto-start function of the CD-ROM drive is active, the installation program 
is started automatically and you can proceed with step 5.

3. Select Run ... from the start menu.

4. Enter the letter for your CD-ROM drive followed by ":\setup.exe" (e.g. "e:\set-
up.exe") in the command line and confirm with OK. 

5. Follow the instructions of the installation program.

 Note!

Installation under Windows NT/2000/XP requires administrator rights!

efesotomasyon.com - Lenze
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4 Introduction

»Cam Designer Professional« is a graphic tool for the easy creation of electronic cams.

4.1 What's new?

 Integration of the 9300EK servo cam target system

– Online download is possible via all drives

– Import of the GDC files for easy import of existing profiles

– Dividing the profiles into five freely selectable segments/sections

– Direct creation of the profile fields *.LC7

 Integration of a technology assistant

– This serves to simply create profiles for cross-cutter applications

 Free assignment of measuring systems for X and Y axes of the worksheet

 Page preview and printing information for profiles and cams.

 Improved import function for interpolation tables

– Spline interpolation for an improved smooth running

– Optional import of an acceleration profile e.g. with a non-linear feedback of mo-
ments of inertia

 Improved parameter setting of the modified trapezoidal acceleration

– Motion profile suitable for cross-cutter applications

efesotomasyon.com - Lenze
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5 User interface

5.1 General settings

5.1.1 Using the direct help

The »Cam Designer Professional« has a direct help which can be used to display informa-
tion about specific areas of the user interface.

 Select the command HelpDirect help and click the area about which you want to 
obtain more detailed information.

If you have opened e.g. the dialog box Settings and click the input field Rated cycles/min,
information about this dialog object is displayed when pressing <F1>.

5.1.2 Language selection

You can always select another language for the menu, dialog and help texts of the »Cam
Designer Professional«.

 The available languages depend on the language files that have been installed togeth-
er with the »Cam Designer Professional«.

 How to select another language...

1. Select command ViewSet language.

2. Go to the Language configuration dialog box and select the desired language.

3. Click OK to confirm your selection and close the dialog box.

 Note!

The »Cam Designer Professional« consists of the »Cam Manager« and the »Cam 
Designer«.
L 3.0 EN - 08/2005 11
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5.1.3 Title bar

The title bar at the top of the application window shows the program icon and the program
name on the left and the window icons on the right.

 With a click on the Window icons � � �  you can change the representation of the 
application window as follows:

– Icon in the task bar (�)

– Full screen (�)

– Window size (�)

 A click on the program icon opens the system menu which also includes commands for 
positioning and changing the size of the application window.

 A click on the window icon U or a double-click on the program icon exits the »Cam De-
signer Professional«

5.1.4 Menu bar

The menu commands can be accessed via the menu bar.

 A click on an item of the main menu opens the corresponding menu and lists the menu 
items contained in it.

 Click a menu item to execute the corresponding function.

– Menu items which are displayed in light grey are currently deactivated because the 
execution of the corresponding function would not make any sense in the current 
program state.

 Tip!

Many frequently used functions can be executed faster by means of the Toolbar
icons. ( 16) 

5.1.5 Workspace

The document windows (worksheets) are displayed in the workspace. 

 When the»Cam Designer Professional« is started, the workspace is blank because there 
are no open projects.

 The worksheet is the area for entering and editing graphic objects.
12 3.0 EN - 08/2005 L
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5.1.6 Status bar

The display is optional.

The program status is indicated in the status bar.

The status bar describes the action which is executed by the menu item selected or a
pressed button of the toolbar and displays the coordinates of the mouse pointer.

 Tip!

If you position the mouse pointer over an icon in the Toolbar or a menu command,
more information about the corresponding function will be indicated in the status
bar.

5.1.7 Document window (worksheet)

If you open a project, the corresponding worksheet will be indicated in a document window
in the Workspace of the Cam Designer Basic.

By default, the document window is displayed on a full screen, i.e. the document window
fills the whole workspace of the»Cam Designer Professional«.

 With a click on the window icons � � �  at the top right of the document window 
you can change the representation of the document window as follows:

– Icon within the workspace (�)

– Full screen (�)

– Window size (�)

 A click on the program icon opens the system menu which also includes commands for 
the positioning and size of the document window.

 A click on the window icon U or a double-click on the program icon closes the docu-
ment window.

 Use the key combination <Ctrl>+<F6> to jump from one document window to the next 
document window.
L 3.0 EN - 08/2005 13
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"Window" menu

The Window menu contains the following commands for the arrangement of the docu-
ment window:

Command Function

New window Opens a new window with the same contents as the active window.
In this way, it is possible to display different parts or views of a worksheet simultaneously.
 • The new window will be automatically the active window and will be indicated above all 

other open windows. 
 • If the contents of an open window is changed, the contents of all other open windows of 

the project change as well.

Cascade Cascades all windows in the workspace.

Horizontal Arranges all windows in the workspace horizontally.

Arrange icons Arranges all windows reduced to an icon at the bottom of the workspace.
 • If a window opens in this section, it may happen that one or all icons are hidden because 

they are under the window.

1, 2, 3... All open windows are listed at the end of the Window menu.
A click on an entry activates the corresponding window (and places it on top of the desktop).
 • The active window is indicated by a hook in front of the entry.
14 3.0 EN - 08/2005 L
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5.2 Cam Manager 

 Go to the Start menu and select 
ProgramsLenzeGlobal Drive Cam Designer Professional 2.3Cam Manager
to start the »Cam Manager« with user interface.

The user interface »Cam Manager« contains the following control and function elements:

 Title bar  Toolbar  Workspace

 Menu bar  Document window (worksheet)  Status bar
L 3.0 EN - 08/2005 15
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5.2.1 Toolbar

The display is optional.

Via the icons of the toolbar you can easily execute some of the most frequently used menu
commands without making a detour via the Menu bar. The selection of the available func-
tions depends on the active mode/window.

 Simply click an icon to activate the corresponding command.

 Tip!

If you move the mouse pointer over an icon, a tool tip pops up providing a short in-
formation on the corresponding function. Moreover, an additional information is
displayed in the Status bar.

Icon Menu command Function

FileNew Creates a new Cam Manager project.

FileOpen Opens a Cam Manager project.

FileSave Saves the project under the current name.

File
Connect to OPC Server

Establishes an online connection with the controllers.

?Information on Cam Manger Opens a dialog box with version info
16 3.0 EN - 08/2005 L
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5.3 CAM Designer

 Go to the »Cam Manager« and select EditStart Cam Designer to start the »Cam 
Designer« with user interface.

The user interface »Cam Designer« contains the following control and function elements:

 Title bar  Toolbar Screen divider  Workspace

 Menu bar Project structure  Status bar Output area
L 3.0 EN - 08/2005 17
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5.3.1 Toolbar

The display is optional.

Via the icons of the toolbar you can easily execute some of the most frequently used menu
commands without making a detour via the Menu bar. The selection of the available func-
tions depends on the active mode/window.

 Simply click an icon to activate the corresponding command.

Icon Menu command Function

FileNew Creates a new Cam Designer project.

FileOpen Opens a Cam Designer project.

The commands New and Open are only active in the Cam Designer if the project has been created 
without the Cam Manager.

FileSave Saves the project under the current name.

FilePrint Prints the project.

EditCut Deletes a selected object and moves it to the clipboard.

EditCopy Copies a selected object and moves it to the clipboard.

EditPaste Pastes a copied or cut object into the current position.

EditUndo Undoes the last action.

EditRedo Redoes the last undone action.

ViewZoom In Enlarges the worksheet view.

ViewComplete View Resets the worksheet view to standard size.

Edit
Acceleration Dimensioning

Opens the dialog box "Acceleration Dimensioning".

File
Connect to OPC Server

Establishes an online connection to the drive/drives.

File
Create LCx-file and Download

Creates the *.LCx file and executes the download.

DrawSelect Selects the drawing objects.

DrawLine Draws a line.

Drawpoint Draws a point (reversal)

DrawPolynomial (2.) Draws a 2nd grade polynomial.

DrawPolynomial (3.) Draws a 3rd grade polynomial.

DrawPolynomial (5.) Draws a 5th grade polynomial.
18 3.0 EN - 08/2005 L
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 Tip!

If you move the mouse pointer over an icon, a tool tip pops up providing a short in-
formation on the corresponding function. Moreover, an additional information is
displayed in the Status bar.

5.3.2 Project structure

The display is optional.

The project structure consists of the tabs Project and Object.

Project

In this tab the master axis and the created slave axes are displayed.

 A double-click on the icon activates the corresponding slave axis. The associated pro-
files are displayed accordingly.

 A mouse-click highlights the name of the master or axis in blue. Then all actions refer 
to this axis.

DrawSloped Sine Draws a sloped sine function (Bestehorn).

Draw
sine/line combination

Draws a sine/line combination.

DrawModified sine curve Draws a modified sine curve.

DrawTable Inserts a table object.

ViewObject Input Mode Input of motion objects.

ViewInterpolation mode Changes to the interpolation mode.

Edit
Start Calculation

Connects the profile segments.

Icon Menu command Function
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Object

This tab shows the list of all objects of the slave axis selected in the active mode. Optional-
ly, the objects of the lower levels, highlighted in grey, can also be shown.

 Each line in the list contains the object type and coordinates of the object. The lines are 
sorted according to the X values (master) as standard. A different sort sequence can be 
achieved by a mouse-click on the fields in the headline.

 It is possible to select one or several objects in the list by means of the mouse. The se-
lection is also transferred to the graph of the worksheet.

 A click with the right mouse button on the corresponding object opens a submenu 
which contains various functions. The property dialogs of the objects can be opened, 
the object can be copied or deleted.

In the Objects tab, the lines, profiles etc. can be edited. 

5.3.3 Screen divider

The screen divider is the border between two non-overlapping windows. In the »Cam De-
signer Professional« there is a screen divider between the worksheet, time derivations and
the object list.

5.3.4 Output area

The display is optional.

 This area displays the time derivations of the objects from the worksheet.

 In this area, the cams of the individual tracks for the target systems Servo PLC and ECS 
EA can be created and edited.
20 3.0 EN - 08/2005 L



Cam Designer Professional
Operation

efesotomasyon.com - Lenze
6 Operation

After the first start of »Cam Manager« the user interface is displayed with an empty work-
space.

 Now you can create a new project (worksheet) or open an existing project.

Entries via the Cam Manager

 The entire project

– Machine structure

– Name of the axis

 The feed constant and gear factor of each axis

– Scaling of the axes for profile creation

 The master axis

– Number of cycles of the machine
The value is a rated value and can maximally amount to 199% during operation.

 The slave axis

– Number of profiles to be stored

– Number of base points to be assigned

– Selection of the data model

 The products (profiles, cams, position markers)

– Product name

– Product number

 Tip!

In the installation directory of the »Cam Designer Professional« you can find exam-
ple projects which can be used to make yourself familiar with the operation of the
»Cam Designer Professional«.

 Note!

The »Cam Designer Professional« consists of the separate programs »Cam Man-
ager« and »Cam Designer«. To make full use of the product management the 
»Cam Manager« should be started first. Many settings can either be made in the 
»Cam Manager« and the »Cam Designer«.

 Note!

For representing dialog boxes no special names are used. In the majority of cases 
the names used in the system are adopted.
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What do you want to do?

�Create a new project

�Open an existing project ( 31) 

6.1 Create  a new project

New projects are created by means of a wizard which issues a number of queries including
the file name and directory for the new project as well as the settings for the master, a
slave and a product.

 How to create a new project...

Go to the toolbar of the »Cam Manager« and click the symbol   or select 
FileNew to create a new project by means of the wizard:

Detailed information about the individual steps can be found in the following sub-
sections.

After the basic settings have been selected by means of the wizard, you can add more
slaves and products to your project if required for your drive application.
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6.1.1 Step 1: Defining the file name and directory for a project

 Tip!

We recommend to provide a project directory for each new project to be created.

 • All path names within a project are relative and refer to the project directory.

 • If you want to transfer a project to another PC, simply copy the project directory 
to the corresponding PC.

 How to define the file name and directory for a new project...

1. Go to the New project dialog box and click the Project save as button to open the 
Save as dialog box.

2. Go to the Save as dialog box and select the directory in which you want to store the 
new project.

3. Enter a name for the new project in the File name input field.

4. Click OK to confirm the settings for the new project and close the Save as dialog 
box.

5. Go to the New project dialog box and click Next to proceed with the next step.

6.1.2 Step 2: General settings

The dialog box General is displayed for the project settings and when recreating a project.
It contains product-independent data.
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6.1.3 Step 3: Defining the properties of the master

The following overview shows the relevant global data for the electrical shaft function.
Here, a perforating machine (slave1) and cross cutter (slave2) are represented schematical-
ly.

Dialog object Description

Button
Select directory 

Opens a dialog for storing the project and LCx files.

Control field Direct CamDe-
signer...

If the control field is active, the Cam Designer is directly arranged below the Cam 
Manager. The height of the Cam Designer windows can be specified in the corre-
sponding input field.

Control field Save project file 
automatically

If the control field is active, the project files of the Cam Manager and Cam Designer 
are stored automatically.

Control field
Activate Expert Mode

If the control field is active, settings can be made in additional dialogs.

Display field Project path Display of the project's memory location.

Variable Description

I1 Value from the division of the gear factors z2/z1 in the dialog box Master

i2/i3 Value from the division of the gear factors z2/z1 in the dialog box Slave

d1 Diameter of the master roll

d2/d3 Diameter of the slave rolls
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Example with a master axis and two slave axes:

Specifications from the data sheet

The entries in the axes reflect the machine constants. Therefore, only work with real val-
ues.

 The master axis has the features of an electrical shaft.

 The master axis can be a real or virtual axis.

Specification Formula Description

Master gear factor = 100 i1 = 100  z2/z1 = 100/1 dialog box Master

Slave gear factor 1/2 = 1 i2/i3 = 1  z2/z1 = 1/1 dialog box Slave

d1 diameter of master roll = 500mm d1 × π Dialog field of Master feed constant

d2/d3 diameter of slave rolls = 1000mm d2 × π or d3 × π Dialog field of Slave field constant

Register Maximum of the master

 Note!

If you only use a virtual master, then enter in the group field Machine under Gear 
factor in the input field z2 100 and in z1 1. This serves to achieve a higher reso-
lution of the master angle.
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 Enter the indicated values into the dialog box Master ein.

 How to define the properties of the master...

1. Go to the Master dialog box and select the properties of the master.

 • The Name of the master is indicated on your worksheet.

 • The Cycles of the axis are the maximum number of operating cycles per minute.

2. Click Next to proceed with the next step.

Dialog object Description

Input field Name Name of the master axis

Input field Minimum In the dialog box Master the 0.0000 must always be entered here.

Combination field Unit * The unit used

Input field Maximum  * Cycle
 • An electrical shaft can be divided e.g. from 0° to 360° or from 0 to 100mm as a 

register.
 • In this case, one master cycle amounts to 360° or 100mm

Input field Cycles/min Production cycles in 1/min
The value can maximally amount to 199%.
 • The machine speed which you want to reach with this profile is set in the input 

field Cycle/min.
 • Serves the display

– to dimension the acceleration
– of the time cams of the cam group.

Input field Rated cycles/min Production cycles in 1/min
The nominal value can maximally amount to 199%.
 • The maximum possible machine speed can be entered in the input field

Rated quantity cycle/min.
This entry is important for the acceleration precontrol. 
(Servo PLC and ECSEA...)

Input field
Gear factors z2/z1 *

Ratio i1 of an upstream gearbox.
 (e.g. 100/1 as real value)

Input field Feed constant  * Path per revolution at the output end of the gearbox. 
(d1×π or one revolution = 360° if an angle is specified)
The physical unit entered is converted to the encoders.
 • Enter, for instance, the leadscrew pitch.
 • When entering increments, enter the number of increments per revolution.

Fields must be filled with * !
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6.1.4 Step 3: Defining the properties of the slave

The entries in the axes reflect the machine constants. Therefore, only work with real val-
ues.

 Enter the indicated values into the dialog box Slave.

Dialog object Description

Input field Name  • The slave axis must have a definite name (e.g. Slave1)
and must not be used for other slaves at the same time.

 • The name of the slave axis is used by the CamDesigner. CamDesigner creates a 
Slave1.LC9 or Slave1.LC7.
In this *.LC9-file or *.LC7-file all profile data, cams and position markers are 
stored.

Input field Minimum * Set range of motion

Input field Maximum  *

Combination field Unit * Selection of the unit

Control field

Absolute data model

Relative data model

When using the absolute data model, you have internal or external (PC) access to 
each single base point. However, a fewer number of base points is available then.
 • If the control field Absolute data model is not marked, the relative data model is 

used. When using the relative data model, more base points are available. The 
base points are distributed automatically.

 • If the relative data model is used, the entire profile can only be accessed with the 
Cam Designer Basic/Professional or Cam Loader to change the profile data.

Input field Curves * Maximum number of the curve profile to be stored.
Reserves should be considered in the maximum number of curve profiles.

Input field Points * Number of base points
Maximally 1 base point/ms or less

Group field
Background drawing

Curves are distinguished by colour.
Improved representation of the profiles in multi-axis applications. This serves to 
make a collision analysis.

Input field
Gear factors z2/z1 *

Ratio between motor and tool
Example: multi-stage gearbox
Gearbox numerator = z2 × z4 = 28 × 32 = 896 (value of z2)
Gearbox denominator = z1 × z3 = 23 × 15 = 359 (value of z1)
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 When selecting the Type "servo cam profiler 9300 EK" you can optionally indicate the 
corresponding GDC file. The Gear factors and the Feed constant will then be automati-
cally read from this file.

 If you have an online connection you can use the  button after the Drive input field 
to assign a drive to the slave axis.

 The selections under Absolute data model and Curves have a direct influence on the 
maximum number of points. If you need more points for the table of base points, deac-
tivate the selection Absolute data model and use the relative data model or reduce the 
value under Curves. 

 The maximum number of Curves depends on the selected type.

 How to define the properties of the slave...

1. Go to the Slave dialog box to select the properties of the slave axis.

2. Click Next to proceed with the next step.

Input field Feed constant  * Path per revolution at the output end of the gearbox.
(If an angle is stated, one revolution = 360°)
The physical unit entered is automatically converted to the encoders.
 • Enter, for instance, the leadscrew pitch.
 • When entering increments, enter the number of increments per revolution.

Group field
Data of drive controller

The selection field Type serves to select a target system.
 • Servo PLC/ECS servo system
 • 9300 EK (9300 servo cam)
The input field GDC file serves to import a GDC file.
 • Only if 9300 EK (9300 servo cam) has been selected.
The button ... serves to select a drive.
Assignment of a drive via bus address.
 • The assignment is only necessary if profiles, cams etc. are to be changed.
 • To change profiles, cams etc. online, all drives must be online.

Fields must be filled with * !

Dialog object Description
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6.1.5 Step 4: Defining the product properties

 Tip!

In the following text, the term "Product" is used for motion profiles, cams and po-
sition markers because product-dependent sequences of motion can be achieved
through different cam profiles.

 • The name serves the »Cam Manager« to internally manage the products.

 • The maximum product number depends on the type of target system selected. 
The slave axes can have different target systems.

 • "0" is assigned to the first product data set.

Dialog object Description

Input field Name Name of the product

Input field Product number Numerical assignment
With this number the profiles, cam group and position markers are activated in the 
drive.
They can be numbered in any order. It is impermissible to assign a number twice.

Control field
Change of ...

The file name is automatically change in the directory

Field Project file for 
Cam Designer

Displays the file name
Use Save as to select another directory

 Note!

Make sure that the product numbers have been selected correctly.
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 How to define the product properties...

1. Go to the Product dialog box and select the product properties:

2. Click Finish to complete the creation of the new project.

After the basic settings have been selected by means of the wizard, the master, slave and
product are indicated on the worksheet:

Next steps

Now you can assign the files for the slave to the product and add more slaves and products
to your worksheet, if required.

�Editing settings on the worksheet  ( 32) 
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6.2 Open an existing project

 Tip!

 • It is possible to open several projects (worksheets) simultaneously in the »Cam 
Manager«. The commands for arranging the worksheets can be found in the 
"Window" menu.

 • With a click on the entries 1...4 in the File menu you can open one of the four 
projects edited last.

 How to open an existing project...

1. Click the symbol    in the symbol bar or select FileOpen.

2. Select the corresponding project file (*.cmm) in the dialog box Open.

3.  Press the button Open .

 • After this, the project worksheet will be displayed in the workspace.

Next steps

�Editing settings on the worksheet  ( 32) 
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6.3 Editing settings on the worksheet

The worksheet consists of a table including all axes and products of the plant or machine
project.

Each line of the table represents an axis and each column a product:

 Tip!

 • If you want to edit a setting on your worksheet, simply click the corresponding 
field in the table.

 • In the Context menu (right mouse key) and the Edit menu, you can find further 
commands, e.g. to add slaves and products to your project or remove them from 
it.

 • The commands of the Window menu can be used to arrange the worksheets in 
the workspace.
 ( 13)�Document window (worksheet) 

Master axis

The topmost line in the table is the master axis. It indicates the product number for each
product (the product number does not refer to the master):

 A double-click on the Name field of the master axis opens the Properties dialog box for 
the master axis.

 A double-click on a Product number field   opens the Properties dialog box for the cor-
responding product.

 Products
 Master axis
 Slave axes
 Product number
 Status (profiles, cams and
     position markers)
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Slave axes

The following table lines represent the slave axes:

 A double-click on the Name field of a slave axis opens the Properties dialog box for 
the corresponding slave axis.

 The status display  indicates the state of the corresponding slave axis and product.

6.3.1 Processing states 

State Meaning

-------- Product is not available in the axis (number of profiles lower than product number).

Global data diff. The global product data do not comply with the Cam Manager.

Object vertical There is an impermissible vertical movement (vertical line).

Overlapped Objects Objects of the ideal cam overlap.

Objects without 
Space

Same X value but different Y value of adjacent objects.

Curve not closed The ideal cam is no closed profile.

No Interpolation There is no interpolation point table.

Interpolation diff. The table of interpolation points does not comply with the ideal cam.

LC Read Error The LC9 and LC7 files cannot be read or are not available.

LC Checksum Error When reading the LC9 and LC7 files a checksum error has been detected.

LC Globals diff. The global data of LC9 and LC7 files do not comply with the product.

LC No Curve Under this product number there is no profile yet in the LC9 and LC7 file.

LC Points diff. The point values in the LC9 and LC7 files do not comply with the point table.

LC CamContactor 
diff.

The cam data in the LC9 file do not comply with the product.

LC PosM/
Segment diff.

The data of the position marker of the LC9 file do not comply with the product.

OK The cam data comply with the LC9 and LC7 file.
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6.3.2 Adding a slave axis

New slaves are added at the end of the list. You can enter a symbolic name for the new
slave which will be indicated on your worksheet.

 The name of the slave is also used as name for the LCx file.

 How to add another slave axis to your worksheet...

1. Select EditAdd slave axis.

2. Define the name and properties of the slave axis in the dialog box Settings.

3. Select OK to accept the setting and close the dialog box.
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6.3.3 Selecting the properties of a slave axis

The properties of a slave axis can always be changed.

 How to change the properties of a slave axis...

1. Double-click the grey field with the name of the slave axis whose properties you 
want to change on your worksheet.

2. Go to the Settings dialog box and enter the new settings.

�How to define the properties of the slave...  ( 28) 

3. Select OK to accept the settings and close the dialog box.

 Tip!

If you want to change the settings of several axes/products you can also use the
command EditProject settings....

In the Settings dialog box that appears you can quickly change between the differ-
ent axes/products by clicking the corresponding tabs:
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6.3.4 Adding a product

 How to add a product to your worksheet...

1. Select EditAdd product.

2. Go to the Project settings dialog box and enter the name and the product number 
of the new product.

 • The product name is indicated on your worksheet.

 • The product number is indicated in the master line of your worksheet. Each 
product number may only be assigned once.

 • Later on, the user can use the product number (cam profile number) to activate 
the corresponding motion profile in the axis.

3. Select OK to accept the setting and close the dialog box.

6.3.5 Setting the product features

The product properties can always be changed.

 How to change the product properties...

1. Double-click the field with the product number of the product whose properties 
you want to change on your worksheet.

2. Go to the Settings dialog box and enter the new settings.

3. Select OK to accept the setting and close the dialog box.
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6.3.6 Deleting a product

 How to delete a product...

1. Select EditDelete product....

2. Go to the Delete product dialog box and select the product to be deleted from the 
project:

3. Click OK to delete the selected product and close the dialog box.

6.3.7 Deleting a slave axis

 How to delete a slave...

1. Select EditDelete slave....

2. Go to the Delete slave dialog box and select the slave to be deleted from the project:

3. Click OK to delete the selected slave and close the dialog box.

 Note!

This function only deletes a product from the project/worksheet. The import 
data assigned to the product are not deleted!

Deleting a product cannot be undone!

 Note!

This function only deletes a slave from the project/worksheet. The correspond-
ing LCx file is not deleted!

Deleting a slave cannot be undone!
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6.4 Starting Cam Designer

When the product and axes have been generated in the »Cam Manager«, the »Cam De-
signer« can be started.

 Tip!

Many actions which have been described for the »Cam Manager« also apply to the 
»Cam Designer«.

 Go to the »Cam Manager« and select EditStart Cam Designer...

 • If only one product is available, the »Cam Designer« directly opens with the 
product.

 • If several products have been generated, the dialog box Start Cam Designer is 
displayed. The corresponding product can be selected in the selection field.

 • After the »Cam Designer« has opened, the profiles can be drawn there.

 Directly click the product name in the »Cam Manager« so that the »Cam Designer« 
directly opens with the product.

 A profile can be generated in the operating range of the »Cam Designer« with the pro-
file objects available.

 Tip!

For additional information go to the »Cam Designer« and select the menu com-
mand ?Help topics or ?Direct help to get more information. 

 Observe the following chapters:

�CAM Designer ( 17) 

�Using the direct help ( 11) 

�Toolbar ( 18)

�Creating  a cam ( 44) 
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6.5 Online connection to the drives

The internal Lenze DriveServer is used for communication between »Cam Manager« and
target system and LCx-file transfer.

• The DriveServer provides easy integration of drives into open automation structures 
based on OPC (OLE for Process Control).

• A specially adapted variant of the DriveServer and the bus server for the system bus 
(CAN) are part of the »Cam Designer Professional« installation package.

 Select FileConnect to OPC server to connect the Cam Loader to the OPC server or 
cancel the connection.
A hook in front of the menu command indicates the connection with the OPC serv-
er.

6.6 Downloading the drive data

If connection with the OPC server has been established, it is possible to transfer the drive
data for several slaves in one step. 

 The configuration files (LCx files) for the selected axes are created first.

 If you have an online connection with the corresponding target system, the LCx file will 
be directly transferred to the target system.

 Note!

With the 9300 servo PLC, the LC9 file can only be downloaded if the target sys-
tem includes a DDS project based on Template Cam.
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 How to download the drive data...

1. The processing states must be OK.

2. Select FileDownload of multiple axes... .

 • This command can only be executed if the Cam Loader is connected to the OPC 
server.

3. Go to the Download to controllers and select the slaves to be downloaded:

 • If the option If necessary, execute a complete download without any question 
is activated, the data will be downloaded without further queries.

 • If the option Don't show this dialog until next program start is activated, this di-
alog will not be indicated again until the next program start. This can be useful 
for the commissioning of standard systems or in case of frequent downloads.

4. Click the Start download button to start the data transfer.

 Note!

 If you have not yet assigned a drive to one of the slaves the Drive selection dialog 
box opens automatically.

 • Double-click the drive to be assigned to the slave in the DriveServer tree.

 • Click OK to confirm your selection and repeat the assignment for other slaves, 
if necessary.
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6.7 Saving the project

 Click the  icon or select FileSave to save the project.

 Tip!

Save your project at regular intervals to protect your data against power failures or
system problems.

If you want to create a backup project on another data carrier or in another direc-
tory use the command FileSave as... instead.

�Saving a project under another name

 Note!

If you open several project simultaneously in the »Cam Manager«, this function 
refers to the project in the active window.
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6.8 Saving a project under another name

 How to save an open project under another name...

1. Select FileSave as... to open the Save as dialog box.

2. Go to the Save as list field and select the directory in which you want to store the 
project.

3. Go to the  Name input field and enter a name for the new project.

4. Click OK to save the project under the specified name in the selected directory and 
close the dialog box.

 • If you select the command FileSave the project will be saved with the new set-
tings.

 Tip!

This way you can create a new project or a backup project on another data carrier
or in a directory other than the project directory on the basis of the current project.

6.9 Closing a project

 Select FileClose to close the open project.

 Note!

If you open several project simultaneously in the »Cam Manager«, this function 
refers to the project in the active window.

 Note!

If you open several Cam Loader projects simultaneously this function refers to 
the project in the active window.
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6.10 Exiting Cam Designer Professional

 Select FileExit or click the Window icon U in the Title bar to exit the »Cam Man-
ager«.

 Note!

If you have not saved the changes made in one or several projects you will be 
asked if you want to save them before exiting the Cam Loader.
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6.11 Creating  a cam 

The following chapter shows how fast you can create a cam.

 How to create a cam:

1. Start »Cam Manager«.

2. Select FileNew or click the symbol .

 • The entries of the routine can be kept except for slight changes.

3. Go to the dialog box New project and press the button Save project under name.

 • Save the project e.g. as project_1 in a specific directory.

4. Press the button Next.

5. Do not change the following three dialog boxes General, Master and Slave1 and 
confirm with Next.

6. Go to the dialog box product and enter e.g. 1 in the input field product number 
(max 47).

 • The »Cam Manager« is then as follows:

7. Press the button Product 1.

 • The Cam Designer opens.

8. Draw two horizontal lines in different positions in the workspace. These will be au-
tomatically connected in the next steps.

9. Use the button  to go to into the profile mode.

 • The profile segments are calculated automatically.

10. Use the button  to go into the interpolation mode.

 • The table interpolation is calculated automatically.
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11. Press the button  to start the recalculation.

 • Profiles and tables are recalculated. The workspace looks then as follows:

12. Establish an online connection to the drive and load it into the drive.

�Online Download ( 46) 
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6.12  Online Download

 How to make an online download:

1. Switch the »Cam Designer Professional« online by clicking FileConnection to OPC 

server or .

 • The button online/offline is only active if the LDS-DriveServer has been started. 

The icon  for the LDS-DriveServer is situated in the status bar.

 • If the red point in the icon becomes green, the system is online.

2. Select EditProject settings to open the Settings dialog box.

3. Select in Controller data the drive to which the data is to be downloaded.

4. Select FileCreate and download LCx-file or  to activate the profile or cam 
download.

 • The data for the current slave axis are written into the *.lcx-file.

 • After the download has been started with the button, a progress dialog appears. 

 Tip!

For the commissioning of production machines, the *.lc9-file can be attached to the 
PLC program.

 Note!

The download time increases if

 • a high bus load (cross communication) exists.

 • many data was changed.
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7 Appendix

7.1 Target systems

Main features of the Software Package - Cam

 48 profiles can be stored in the PLC

 289 base points per profile in the relative data model

 116 base points per profile the absolute data model

 Increased number of the available base points with reduced number of profiles re-
served

 48 cam groups can be stored

 Three tracks per cam group

 Four cams per track

Main features of the 9300EK servo cam

 8 profiles can be stored

 256 base points per profile in the relative data model

 64 base points per profile the absolute data model

The »Cam Manager« which is included in the »Cam Designer Professional«, reflects the
view on the machine and is the central input place for machine constants and profile data.

The »Cam Manager« helps you to create the minimum system by dialog boxes described in
detail. The Cam Manager serves to add and delete the tools and product data.
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7.2 The cam group

Go to »Cam Designer Professional« and select the command ViewEdit Cam to transfer
the bottom window of the Cam Designer Professional to the corresponding mode.

7.2.1 Defining the cam type and cam reference

 Tip!

The cam group can either refer to the X axis or to the Y axis. The cam group func-
tions are available in the context menu of the right mouse button.

 How to define the cam type and cam reference:

1. First, define the cam reference for the current data set under Cam for Slave Axis.

 • Subsequent changes are not possible. The selected cam data will be deleted and 
must be entered again.

2. The cam types for the individual tracks can be defined using the commands shown 
in the context menu.

 • If you right-click in the track, you can directly change the cam type.

3. Select Add New Cam to add a new cam to the corresponding track.

 • You can add up to four cams to every track.

 Note!

Only available for Cam software package. The settings only apply to the product 
selected. For the other products, the settings have to be repeated.

Position cam in positive effective direction
Position cam in negative effective direction

Position cam Both
Time-based cam in positive effective direction
Time-based cam in negative effective direction
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7.2.2 Cam types

Select Properties of Cam to edit the cam subsequently. In this dialog, time and length data
can be accurately entered. The dialog box is always the same for all cam types. Only the cor-
responding fields on the dialog box are active.

Illustration Meaning

Position cam in positive effective direction
Switch on and switch off point are defined by positions.
The cam switches if the direction of the axis is positive (positive speed).

Position cam in negative effective direction
Switch on and switch off point are defined by positions.
The cam switches if the direction of the axis is negative (negative speed).

Position cam in positive and negative effective direction
Switch on and switch off point are defined by positions.
The cam switches in positive and negative direction of the axis.

Time-based cam in positive effective direction
The cam switches on at the switch on point if the direction of the axis is positive (positive 
speed).
After the selected time, the cam switches off.

Time-based cam in negative effective direction
The cam switches on at the switch on point if the direction of the axis is negative (negative 
speed).
After the selected time, the cam switches off.

Dialog object Meaning

Input field Left Initial value of the cam

Input field Right Final value of the cam

Selection field Effective Di-
rection

Positive or negative effect

Input field Length [ms] Cam is active (only with time cam)
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7.3 Error numbers, causes & remedies

Error number Cause Remedy

Errors within the DriveServer

E7C18000 Error during download preparation. Repeat download.

E7C18001 PLC has not stopped. Stop the PLC program in the target system.

E7C18002 Controller inhibit is not set. Set controller inhibit in the target system 
(e.g. via terminal 28 or code C0040).

E7C18003 Incorrect data type (no LC9 file). Create new LC9 file.

E7C18004 Check sum check is negative
(faulty check sum).

Restart the download. Increase time-out 
time in the system bus configuration tool 
(e.g. to 3 seconds).

E7C18005 Item can momentarily not be accessed due to 
download.

Repeat download after a few minutes or re-
start your PC. 

E7C18006 Target system is momentarily busy copying 
RAM blocks.

Start the PLC program in the target system.

E7C18007 Error occurred after the download. Repeat download.

E7C18008 Error after version comparison during down-
load of an LC7 file.
 • Different versions in LC7 file and target 

system. 

Update the operating system of the 9300 EK.

E7C18009 No template "Cam" in the target system. Create DDS project based on Template Cam 
and transfer it into the target system.
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7.4 Glossary

A

Absolute data model Contains both the X and the Y coordinate. Therefore requires more space than
the relative data model. The points are 1:1 transferred from the Cam Loader to
the target system:

 • Advantage: The distance between the points can be variable. This allows to 
optimise the distribution of the points according to the cam profile charac-
teristics.

 • Disadvantage: Compared to the relative data model, less points can be 
saved.

Relative data model

Application window Window in which programs are displayed under Windows.

C

Code Lenze device parameter used to select the device functionality.

COM Abbreviation for "Component Object Model": Architecture developed by Mi-
crosoft® for the interaction of separately executable software components
(objects) that communicate with each other in the same way and are only con-
nected to each other when the program is being executed.

Collision analysis Layered presentation of several motion profiles to recognise an overlapping of
the profiles.

D

DCOM Abbreviation for "Distributed Component Object Model": COM in which the
executable objects can be distributed to different computers within a local
network.

COM

DDS Abbreviation for "Drive PLC Developer Studio": Development environment for
the creation of IEC 61131 programs for Lenze PLCs.

Document window Window with graphical user interface displayed by a user program in which a
document is created, displayed and edited. Document windows are usually
sub-windows of the program windows. 

Drive PLC Developer Studio See DDS.

DriveServer Lenze software which enables easy integration of drives into open automa-
tion structures based on OPC ("OLE for Process Control").

OPC

G

Global Drive Loader Lenze software used to transfer PLC programs, parameter sets and application
data to Lenze target systems.

H

Hyperlink Highlighted reference which is activated by a mouse click.
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I

IPC Abbreviation for Industrial PC. Industrial PCs are used in case of special envi-
ronmental conditions, e.g. dirt or vibrations. They are slot CPUs with powerful
processors and TFT displays (often with touch screens).

O

OLE Abbreviation for "Object Linking and Embedding": Integration of operational
objects into other applications, e.g. Microsoft® Excel spreadsheets into Micro-
soft® Word documents.

OPC Abbreviation for "OLE for Process Control": Defines an interface based on the
Microsoft® Windows® technologies OLE, COM and DCOM which enables data
exchange between different automation devices and PC programs regardless
of driver and interface problems.

COM
DCOM

P

PDF Abbreviation for "Portable Document Format". Universal file format devel-
oped by Adobe for the exchange of electronic documents. The Adobe® Read-
er® is provided free of charge and can be used to display and print PDF files
independently of the application and platform used to create them.

PLC Abbreviation for "Programmable Logic Controller".

PLC

R

Relative data model Only contains the difference between adjacent Y coordinates and therefore re-
quires less space than the absolute data model. The distance between the X
coordinates is transferred as a fixed-comma value to the target system. This
leads to a certain difference between the imported data and the coordinates
calculated by the target system. To compensate for this inaccuracy, the Y val-
ues are re-calculated by means of interpolation . 

 • Advantage: Compared to the absolute data model, more points can be 
saved.

 • Disadvantage: The distance between the X coordinates of the points must 
always be the same.

Absolute data model

T

Title bar Bar at the top of the application window including the program icon and the
program name on the left and the window icons on the right.

V

VDI 2143 VDI guideline "Motion rules for cam mechanisms"

W

Worksheet Table including all axes and products of a system or machine project.

Window icon Button at the right end of the title bar which can be used to change the size of
the window or to close the window.
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